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Introduction
About WealthTec
WealthTec LLC is a firm specializing in high-end financial and estate planning services with a niche in
the area of advanced software applications for experienced professionals. Founder and President,
Howard L. Eisenberg, CPA/PFS, CFP®, CIMA®, CPWA®, CTFA®, CLU®, ChFC®, CASL®, is the
author of WealthTec® Suite. WealthTec products are designed for professionals whose focus is
primarily in advising business owners, corporate executives and other wealthy individuals and families
on financial and estate planning matters. While effective use of WealthTec Suite requires a solid
background in various advanced planning disciplines, the new modeling and client presentation
capabilities you will possess as a WealthTec Suite user will give you a significant edge on your
competition.
For more information on WealthTec, visit our Web site at wealthtec.com or contact Howard Eisenberg
directly at (301) 725-1437 or howard@wealthtec.com.

About WealthTec® Suite
WealthTec Suite is a wealth planning platform that can be used effectively in serving everyone from the
mass affluent to high-net worth and ultrahigh-net worth clients. It combines tactical and strategic
planning tools with a series of estate and charitable planning presentations, and is second to none in
the high-end marketplace. This suite was developed by Howard L. Eisenberg, a seasoned software
developer who is also an experienced wealth planner, having spent a decade with Ernst & Young LLP
serving affluent clients before founding WealthTec.
WealthTec Suite consists of planning models in the following major groups:
•

Global – Pinnacle, the global planner, is also an asset allocation planning tool

•

Cash Flows and MCS – includes basic planning tools for retirement and/or survivor cash flow
planning and Monte Carlo simulations

•

Strategic Wealth Planning – anchored by the Cash Flow & Estate Planner, a strategic
planning tool with powerful cash flow, income tax and estate planning capabilities, including
Monte Carlo simulations capabilities

•

Strategic Estate Planning – anchored by EstatePro, an advanced estate, charitable and
insurance planning tool

•

Qualified Plans & IRAs – this group of tools compares qualified plan & IRA distribution
planning scenarios for financial and estate planning

•

Tactical Planning – this group includes focused charitable and estate planning tools.

In addition to the planning tools listed above, the suite also includes a series of presentations covering
topics pertinent to estate planning, charitable planning and retirement plan distribution planning.

About the Author
Founder and president, Howard L. Eisenberg, CPA/PFS, CFP®, CIMA®, CPWA®, CTFA®, CLU®,
ChFC®, CASL®, is the creative force behind WealthTec. As WealthTec clients can attest, Howard's
expertise and dedication to the art and science of financial, tax and estate modeling sets him apart. In
addition to distilling his many years of professional and industry experience into the most sophisticated
suite of planning tools available, Howard also provides hands-on product support to the WealthTec
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client base. His responsiveness and attentiveness to your needs goes a long way towards helping you
make the most of your experience. His extensive work with corporate executives, business owners and
other high-net worth individuals enables him to offer the kind of products and services you can't find
anywhere else.
Prior to founding WealthTec, Howard was a senior manager with Ernst & Young LLP, a firm he proudly
represented for more than 10 years. After serving the firm's clients directly for several years, he was
recruited to its National Tax Department in Washington, DC. There he specialized in providing high-level
support to the firm's client service professionals in the nature of proprietary products, planning solutions,
technical research and communications. Howard was an instructor in Ernst & Young's continuing
professional education programs, served on the editorial boards of some of its popular national
publications and was a major contributor to the bimonthly Ernst & Young Financial Planning Reporter
periodical. He also served as a guest lecturer at local, regional and national professional and industry
conferences. Howard holds Bachelor of Science degrees in accounting, psychology and zoology, a
Master of Science degree in financial planning and numerous professional designations and licenses.
In addition to his WealthTec activities, Howard is also a songwriter, musician, conceptualist and artist
(www.howardlawrencemusic.com). He and his wife Linda have been happily married for 32 years.

Getting Started
System Requirements
WealthTec Suite is designed for the experienced professional with considerable subject matter
expertise in a variety of financial, tax and estate planning areas. Each component of the suite focuses
on one or more aspects of wealth management for the mass affluent, high-net worth and ultrahigh-net
worth individuals. If you have any questions about how WealthTec Suite can assist you in your wealth
advisory practice, please do not hesitate to contact WealthTec.
System Requirements
Before attempting to install and operate this software, please review the following minimum system
requirements to ensure that your hardware and software configurations are compatible with WealthTec
Suite and robust enough to provide satisfactory performance:
•

Installation on the local hard drive or on a terminal server that is part of a Remote Desktop
Services configuration

•

32-bit or 64-bit Windows 7 or 10

•

32-bit or 64-bit Microsoft Excel® and PowerPoint® 2010 or later

•

4GB RAM (tactical planners)/12 GB RAM (strategic planners) and a robust processor

If you have any questions or problems regarding these requirements, please consult your IT
department.

Installing & Operating the Program
The WealthTec Suite setup file can be downloaded at any time by visiting wealthtec.com/downloads/.
The current version of the software is always posted on that page.
Installing the Program
In order to install WealthTec Suite for the first time in a given calendar year, you must be supplied by
WealthTec with a Product Key. Installing current-year updates subsequent to the initial install in a
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given calendar year, however, does not require you to reenter your Product Key (i.e., the program is
able to detect the existence of a valid Product Key on the computer where the program is installed, and
automatically inserts that key in the installer).
NOTE: Excel must be closed before trying to install the program.
Silent Install
You can set up the WealthTec Suite installer to run silently. To do so, you must first create an
Install.ini file, and save it to the folder where the WealthTec Suite setup file is located. The first three
lines of the file are formatted as follows:
[General]
ProductKey=
InstallRoot=
The ProductKey is the Product Key supplied by WealthTec. If the WealthTec Suite install path is the
default path the InstallRoot should be left blank. Otherwise, add the custom install path after
InstallRoot=.
Next, to invoke the silent install procedure, enter the following in the Open block of the Windows Run
dialog: "Drive:\Path\<Setup File>" /VERYSILENT and click OK.
Example: If the setup file were WealthTecSuite.2019.1.exe and the file were located in the C:\SilentWT
folder your text in the Open block would be "C:\SilentWT\WealthTecSuite.2019.1.exe" /VERYSILENT.
When in doubt—or if you receive a Windows error message—try locating the setup file via the Browse
button in the Run dialog. Windows will automatically put the correct path before the /VERYSILENT
command.
What Gets Installed
The default installation path for WealthTec Suite is C:\Program Files (x86)\WealthTec\WealthTec Suite
for the 32-bit version and C:\Program Files\WealthTec\WealthTec Suite for the 64-bit version. However,
you can select a different installation path during the setup routine, if desirable.
After successfully installing the program the following folder/file structure will be located within the
<installation path>\WealthTec Suite folder:
•

Data

•

Help

•

Images

•

Planners

•

Presentations

•

Uninstall

•

7520Rates.xls

•

Application.xls

•

AppConfig.ini

•

Contents.xls

•

RegisterApp.exe

•

RegisterApp64.exe

•

RemoveFL.exe

 Copyright 1999-2019 WealthTec LLC. All Rights Reserved.

6

WealthTec® Suite Technical Guide: 2019 Edition

•

ResetExcel.exe

•

ResetFL.exe

•

ResetPrivileges.exe

•

UnregisterApp.exe

•

UnregisterApp64.exe

•

User.xls

•

VBA.xls

•

WealthTec.exe

•

WealthTec.ico

•

WealthTec.xll

•

WealthTec64.xll

•

WealthTecApp.dll

•

WealthTecApp.ini

•

WealthTecApp64.dll

•

WealthTecApp64.ini

•

WealthTecLib.dll

•

WealthTecLib64.dll

NOTE 1: The WealthTec Excel Addin (WealthTecApp.dll/WealthTecApp64.dll) and WealthTec
Function Library (WealthTecLib.dll/WealthTecLib64.dll) are each Excel add-ins.
NOTE 2: The files with 64 in the title are operable only with the 64-bit version of Microsoft Office.
Lastly, the setup routine creates a copy of the AppConfig.ini file, adds crucial product-related
information to the file, and then drops a Config.ini file into a newly-created
C:\ProgramData\WealthTec\WealthTec Suite folder.
Operating the Program
Certain WealthTec Suite procedures may be negatively impacted by Excel security settings that
prevent the activation of key Excel macros. Please refer to the Support/Troubleshooting: Excel Security
Settings help section for details.
Upon initially launching the program, WealthTec Suite creates copies of the Custom and Images
folders, along with the 7520Rates.xls and Contents.xls files and drops them all into the
C:\ProgramData\WealthTec\WealthTec Suite folder. The program also creates copies of the Data folder
and User.xls file, and drops these into a new C:\Users\<User
Name>\AppData\Roaming\WealthTec\WealthTec Suite location on your hard drive. It does so, because
you would normally have write-to privileges for these folders, allowing you to freely update the contents
of the files and/or folders, as necessary.
NOTE: During a WealthTec Suite session you can easily navigate to the
C:\ProgramData\WealthTec\WealthTec Suite folder by selecting Shared Settings Folder from the
Tools menu. Similarly, by selecting User Settings Folder from the Tools menu the program opens the
folder containing the default Data folder and User.xls file.
IMPORTANT: Unless or until you change the default path for saving/retrieving Client data files (please
see Technical Architecture & Functionality/General: Settings for details) WealthTec Suite saves Client
data files in the Data folder located on your computer's hard drive at C:\Users\<User
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Name>\AppData\Roaming\WealthTec\WealthTec Suite. This folder also includes a copy of the
WealthTecDemo.dat sample data file.
The remainder of this help system has all of the specific guidance concerning effective operation of
WealthTec Suite.
Uninstalling the Program
You can uninstall WealthTec Suite by selecting Uninstall WealthTec Suite from the Start/WealthTec
menu or by using the Start/Windows System/Control Panel/Programs/Uninstall a program method.
NOTE: Uninstalling WealthTec Suite removes all of the program's installed components with the
following exceptions:
C:\ProgramData\WealthTec\WealthTec Suite…
•

Custom folder and contents

•

Images folder and contents

•

Config.ini file

C:\Users\<User Name>\AppData\Roaming\WealthTec\WealthTec Suite…
•

Data folder and contents

•

User.xls file
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Technical Architecture & Functionality
Overview
WealthTec Suite is a Microsoft Office-based wealth planning system with Excel-based planning tools
and PowerPoint-based planning presentations. WealthTec Suite includes technical components that
integrate with Office as Excel add-ins: WealthTecApp and the WealthTec Function Library.
Upon launching WealthTec Suite you will notice that the native Excel ribbon is replaced with the
custom WealthTec Toolbar. This user-friendly design presents all of the program's technical features
and functions in a clear, easy-to-navigate layout. The WealthTec Toolbar was co-designed by
WealthTec and MathTec, LLC, whose president, Jeff Pickard, is the expert programmer who developed
the software code for the WealthTecApp and WealthTec Function Library. Jeff is also the former
president of zCalc, LLC, having been the driving force behind zCalc™ from its inception in the mid-90s
until its sale to Thomson-Reuters in December 2004.
The following sections discuss all of the key features of the WealthTec Toolbar.
NOTE: Adjacent to the WealthTec tab—this houses the WealthTec Toolbar—is the File tab. The File
tab is native to Office, and should be ignored when operating WealthTec Suite.

Toolbar/General
Exit Program
If you wish to terminate the current WealthTec Suite session click the Exit Program button. Upon
doing so you will be prompted to confirm your intention to exit the program. Select Yes to exit or No to
continue the session.
NOTE: If the program detects the presence of unsaved data you will receive a prompt to save those
data before exiting. Select Yes to save the data, No to exit without saving or Cancel to continue the
current session.

Settings
The program offers a number of control settings that can improve your overall experience with
WealthTec Suite. Select Settings to launch the User Settings dialog, the details of which are
discussed below.

GENERAL
Default Folders
•

Data Folder. The data path for the Data File is shown on the General tab. You can change
the default path by typing in a new one. However, it must be the exact data path, so please
double-check your entry before clicking the OK button. It is generally safer to use the Browse
button to ensure the correct path is recorded.

•

Import Folder. You can also establish a default path for Importing Data files by typing the
desired path, which must be exact. Please double-check your entry before clicking the OK
button. It’s generally safer to use the Browse button to ensure the correct path is recorded.
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•

Export Folder. Similarly, you can establish a default path for Export files by typing the
desired path, which must be exact. Please double-check your entry before clicking the OK
button. It is generally safer to use the Browse button to ensure the correct path is recorded.
Also, by default, export files opened in a new instance of Excel show gridlines, along with row
and column headings. This makes it easier to work with those files. If desired, check the
Remove Gridlines From Exported Reports box to disable the gridlines, which do not appear
on printed output regardless of this setting (if they do, you must have checked the Print
Gridlines option in your Page Setup/Sheet option in Excel).

Report Cover Image Location
•

Alignment. You can direct the program to insert your firm's logo (or some other desired
image) at the top of each report cover page and report section divider by clicking the Open
Images Folder, and dropping a Cover.jpg image file in that folder. Select the location of the
logo by making a selection from the Alignment drop-down list. NOTE: The program does not
resize the graphic file for you to ensure it fits properly. Therefore, resizing the image in a
graphics program via trial and error may be required.

•

Exclude Header/Footer Images From Report Cover/Section Dividers. In addition to the
larger report cover/section divider logo image, you can also insert a smaller graphic (e.g., your
firm's logo) in the report headers and/or footers. Check the box to exclude these smaller
graphic images from the report covers and section dividers. Tip: you may want to do this to
avoid displaying two sizes of an identical image on the report covers/section dividers.

Workaround For Conditional Formatting Error In Microsoft Excel 2010
•

Apply Data Input Conditional Formatting Workaround. There is a known error in Excel
2010 that negatively impacts Excel's conditional formatting feature. (The error does not affect
other versions of Excel.) The error disrupts WealthTec Suite's input screen conditional
formatting procedure, which is the feature that enables the identification of active/inactive data
input fields. Check this box to enable WealthTec Suite's built-in workaround, so that
conditional formatting is applied properly in Excel 2010. CAUTION: The workaround requires
a calculation routine that produces a noticeable performance drag while entering data in The
Cash Flow & Estate Planner, EstatePro and Synergy, so just uncheck the box if the
workaround hinders your data input progress. NOTE: Excel 2010's conditional formatting error
does not affect WealthTec Suite's calculation formulas or the rendering of reports in any way.

HEADERS/FOOTERS
•

Headers. Headers (left, center and right) can be added at your discretion, and these appear
on each page of exported or printed output. CAUTION: Please select Print Preview from the
Print menu prior to exporting or printing the first time after entering the current headers to
ensure that they fit properly within their allotted space.

•

Footers. Footers (left, center and right) can be added at your discretion, and these appear on
each page of exported or printed output. Footers have already been provided by WealthTec
that show output page numbers (right) and a Date notice (left), with the date determined by
your computer's system settings. You may change (or delete) the preset footers.

•

Formatting Codes. For each header and/or footer enter the applicable formatting code in the
required format (i.e., an ampersand followed by the applicable letter). NOTE: If you enter &G
as a header/footer the program inserts the Header.jpg or Footer.jpg file image located in the
Images folder. Click the Open Images Folder to drop the corresponding
Header.jpg/Footer.jpg file in that folder. NOTE: The program does not resize the graphic file
for you to ensure it fits properly. Therefore, resizing the image in a graphics program via trial
and error may be required.
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•

Font Size in Points. Enter the desired size for header and/or footer text.

PRESENTATIONS
PowerPoint
•

Transition. WealthTec Suite's presentations do not include slide-to-slide transitions by
default. However, you can apply transitions by making a selection from the Transition dropdown list.

•

Template. WealthTec has applied its preferred design layout to the presentations, but you
can substitute your own template if desired. NOTE: Your template must be named
Default.pot, Default.potx or Default.potm (i.e., save the Slide Master/Title Master file as a
PowerPoint template), and it must be dropped into the WealthTec Suite Presentations
folder.

•

Footer Text. Enter the desired footer text, which appears at the bottom-left of each
presentation slide.

•

Open Presentations Folder. Click this button to open the WealthTec Suite Presentations
folder. There you will find all of the presentations included with this program. Please feel free
to copy and paste them to a different location for easy access in their native form.

•

Open Custom Folder. WealthTec Suite's presentations can be edited. If you wish to make
changes to a presentation open the FileName.ppt file in a new instance of PowerPoint, make
your desired edits and save the updated file. Click the Open Custom Folder to drop the
updated presentation file into the WealthTec Suite Custom folder. When you click the Static
Presentation or Linked Presentation toolbar icon your custom presentation is shown in the
list in lieu of WealthTec's standard presentation. NOTE 1: Do not change the name of the file
containing the presentation. NOTE 2: If you intend to use the Linked Presentation feature
there are some editing restrictions. First, you cannot insert new slides or delete existing ones.
Otherwise, the data upload procedures are compromised. Second, you cannot edit slides that
are linked with the corresponding WealthTec Suite planner—these are the slides containing
the graphical examples—because those slides are replaced during the live presentation with
objects that are transferred from the planner to the presentation.

IMPORTANT: Every time you update your custom presentations you should back them up to a location
outside WealthTec Suite. Although WealthTec has designed its installer routines so that files contained
in the Custom folder are preserved indefinitely, it's simply good practice to backup your work prior to
installing any updates.

Tools
Following are brief descriptions of the Tools menu items.
Load Default Values
Select this option to import the program defaults for all data input items into the active planner.
CAUTION: Doing this overrides all of the current data, including items imported from Pinnacle.
Load Global Values
Select this option to import data from Pinnacle.
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NOTE 1: Only those data input items with a corresponding variable in Pinnacle are imported.
NOTE 2: Since the program automatically imports Pinnacle data into the active planner when you're
building a new Case, you would only select this option if you updated the current Pinnacle data set and
the item in the active planner was not updated upon opening an existing Case. This could occur if you
did not select "Yes" for the item in question on the Pinnacle: Current Portfolios & Asset Allocation for
Strategic Planning screen under UPDATING SAVED CASES IN PLANNERS.
Import Data
Select this option to launch the Import Data dialog. Please refer to the Effective Use of This System:
Importing an Updated Template help section for a complete discussion of this function.
7520 Rates
Select this item to launch the 7520 Rates dialog. Currently, this form displays §7520 rates starting in
January 1998 and ending with the month in which you installed your current version of WealthTec
Suite. Each month, the IRS announces the §7520 rate in a Revenue Ruling. You can update your 7520
Rates form manually by entering the applicable rate(s) in the form, and clicking the OK button.
NOTE: WealthTec applies the most recent §7520 rate to the remaining months in the current year.
Thus, you only have to update the 7520 Rates dialog when the IRS changes the §7520 rate in the
future.
Zoom
Select this option to adjust the magnification of the current viewing area.
Shared Settings Folder
Select this item to open the C:\ProgramData\WealthTec\WealthTec Suite folder, which contains files
and folders which you can update by saving a file and/or dropping in files (e.g., images) to be used by
WealthTec Suite. This folder contains files that would typically be shared amongst users in a group,
and therefore, is distinguished from the User Settings Folder, as described below.
User Settings Folder
Select this item to open the location on the local hard drive that contains the WealthTec Suite Data
folder and the User.xls file. The User.xls file contains the user-defined settings recorded from the User
Settings dialog, along with saved Report Sets used for exporting and printing.
NOTE: The folders and files contained in the Shared Settings Folder and User Settings Folder are
automatically copied and pasted into their target location by WealthTec Suite upon launching the
program following its initial install.

Toolbar/Case Building
Managing Client/Case Data
WealthTec Suite has a Client/Case data structure. All data saved under a particular file name (e.g.,
WealthTecDemo.dat) is stored in a single Client data file.
Client vs. Case
The Client data file is associated with Pinnacle, which serves as the suite's global planner. Pinnacle
stores a single set of inputs per Client data file. In contrast, Cases are associated with all of the other
planners. You can save an unlimited number of Cases in each planner in a single Client data file.

 Copyright 1999-2019 WealthTec LLC. All Rights Reserved.

12

WealthTec® Suite Technical Guide: 2019 Edition

Saving a Client Data File
To save a new Client data file select Save Client As… from the Save menu. This opens the Save
Client As window. Enter a file name in the File name block and hit Save. The program automatically
appends the .dat suffix when you save the file.
To resave the existing file (e.g., after updating your Pinnacle data set) you can either click the Save
toolbar button or select Save Client/Case from the Save menu when Pinnacle is the active planner.
NOTE: Selecting New Client clears the current data from Pinnacle, giving you a fresh start with default
values loaded into Pinnacle.
Saving a Case
After saving the Client data file you can build one or more Cases in one or more planners. To start,
click the Planners toolbar icon to open the Planners dialog, select the desired planner, click Open, and
then enter your Case data in that planner.
NOTE: Data saved in Pinnacle automatically flow into the planner upon first opening it (or upon
selecting New Case from the toolbar), so your data entry tasks in the planner are limited to completing
the active planner's unique data set.
To save a new Case in the active Client data file select Save Case As… from the Save menu. This
opens the Save Case As dialog. Enter a Case Name in the Name block and hit Save.
NOTE: The Case Name should describe the active Case or scenario (e.g., "Cash Flows with Current
Asset Allocation," "Sale of FLP Interest to Grantor Trust"). Case Names appear on each report cover
page and report section divider, as well as above the banner of each report page. They also appear in
the Cases dialog, listed by planner.
To resave the existing Case (e.g., after updating your planner data set) you can either click the Save
toolbar button or select Save Client/Case from the Save menu before exiting the active planner.
To save an additional Case in the active planner, select Save Case As… again. Then enter a new
Case Name in the Name block (e.g., "Cash Flows with Recommended Asset Allocation"). This
preserves your existing Case(s) in the active planner, while creating a new Case with a unique data set.
NOTE: Creating multiple Cases in a planner allows you to perform what-ifs by comparing those Cases
either directly (i.e., if a WealthTec Suite comparison tool exists for this purpose) or indirectly (e.g., by
exporting the results of each Case to Excel and building a side-by-side comparison yourself).
Managing Cases
You can view the list of Cases in the active Client data file by clicking the Cases toolbar button. Select
Open to open the selected Case along with the corresponding planner.
To rename a Case click the Rename button. This opens the Rename Case dialog. Enter a new name
in the New Name block, and select OK to record it.
To delete a Case click the Delete button. This opens the Delete Case? dialog where you'll be prompted
to confirm your desire to delete the selected Case. Select Yes to confirm or No to cancel the delete
command.
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Data Saving Tips
It's a good idea to save your data at reasonable intervals (e.g., after completing all or a portion of an
input screen) rather than waiting until your session is complete. There is no way to recover data that
have not been saved.
You should create the Client data file at the beginning of your session even if you're bypassing
Pinnacle. That way, you'll only select Save Client As… once for the active project. After that you'll
either select Save Client/Case (or click the Save toolbar button) if you're working in Pinnacle or Save
Case As… (or click the Save toolbar button) if you're working on a new Case/existing Case in a
planner.
IMPORTANT: If you're working on a Case in a planner and you select Save Client As… to save your
data you are NOT saving your Case data, but merely creating a duplicate Client data file with Pinnacle
data. The only way to save Case data is to follow the steps discussed above under Saving a Case.
FINAL NOTE: If you've neglected to save a Client data file before working in a planner on a new Case,
when you attempt to save the Case by selecting Save Case As… (or by clicking the Save toolbar
button), you'll activate a pop-up message instructing you that you have to save a Client data file before
you can save the current Case. In that situation, the program opens the Save Client As dialog followed
by the Save Case As dialog, directing you to complete the two-step data-saving process in quick
succession.

Toolbar/Deliverables
Export to PDF
The Portable Document Format (PDF) is an open standard for document exchange that was created by
Adobe®. Due to the ubiquity of PDF files today, converting a file that can be opened and read only by a
particular program to a PDF will make it easier for you to transmit those files to clients, co-workers, etc.
without having to ensure that the recipient has the program (or derivative) that you used to create the
original file.
IMPORTANT: The most efficient and effective way of creating a PDF file from WealthTec Suite's output
is to use the program's Export to PDF feature, as discussed in this section. However, you can also
export the desired report set to Microsoft Excel and create the PDF file from the Excel export. Exporting
to Excel in lieu of exporting directly to a PDF file is warranted in the event you wanted to modify the
program's output before creating the PDF file.
Exporting Your Session
Once you've completed your data input and reviewed the output, you can access the Export to PDF
dialog by clicking the Export to PDF toolbar icon.
Upon launching the dialog the Export What? section defaults to the Current Page. In this case, the
bottom-right section lists the name of the menu or submenu item currently in view.
To create a multi-page export, you can either select All Pages or Customize. As a result of selecting
All Pages, all active reports are listed in the below-right section in the order in which they appear in the
various reports menus.
Selecting Customize activates the Category drop-down list. All active reports are listed in the section
immediately below in the order in which they appear on screen. You can then build a customized export
by making your desired selections from the Category drop-down list. Clicking on the >> button moves
all items listed in the section under the drop-down menu to the Pages to Export section. Clicking on the
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<< button moves the items back. You can also reorder the items listed by highlighting one item at a time
and clicking on the Up or Dn buttons until the item is placed where you want it.
NOTE: You can move individual items back and forth between sections by first highlighting the item and
then by clicking on the > and < buttons.
To create the Export Path where your export file will be created, click on the Browse button. This
brings up the Export window. Enter a file name in the File name section—the default name is <Planner
Name> Export.pdf—and navigate to the desired destination for the export file. Click on Save to record
the Export Path and the export file name.
NOTE: If you've entered a default path for saving export files on the Settings/User Settings/General
tab, that path is recognized by the system. You'll notice that the system navigates to your default export
path when you select Export Path to open the Export window.
Once the bottom-right section of the Export to PDF dialog lists the desired output items in the preferred
order, click on the OK button. The program creates the export file from the items listed, in the order in
which they appear in this section.
Open PDF After Exporting
If you check the Open PDF After Exporting box the program opens the PDF export file immediately
after creating it.
Saving and Managing Custom Sets
You can establish exporting preferences in WealthTec Suite that are unique for each planner. Here's
how this feature works:
1.

Select Customize from the Export What? section.

2.

Create your custom report set by following the steps outlined in the Exporting Your Session
section above.

3.

Once the items listed in the below-right section meet your requirements, click Save in the Sets
section. This brings up the Save Set As dialog.

4.

Enter a name for the export set in the New Name block and click Save.

5.

Click New to build another custom set and repeat steps 1-4.

To rename a custom report set click the Rename button. This opens the Rename Set dialog. Enter a
new name in the New Name block, and select OK to record it.
To delete a custom report set click the Delete button. This opens the Delete Set? dialog where you'll be
prompted to confirm your desire to delete the selected custom report set. Select Yes to confirm or No to
cancel the delete command.
TIP: Reports are Case-sensitive, meaning that certain reports are activated or inactivated depending on
the Case data. Therefore, if you're using this feature, you should evaluate the merits of developing
alternative custom sets in a given planner.
NOTE TO MULTIUSER GROUPS: The custom report sets you develop for exporting and printing
purposes are stored in your user settings file (i.e., User.xls). You can develop various custom report
sets for the group as a whole, and distribute one User.xls file to the group. Click the Tools/User
Settings Folder to access the User.xls file. Copy the User.xls file that stores the group's custom report
sets, and paste it into the User Settings Folder for each user in the group. When prompted whether
you wish to overwrite the existing file select Copy and Replace in the Windows Copy File dialog.
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Export to Excel®
WealthTec Suite offers you the flexibility of modifying the system-generated output in any manner
desired by allowing you to create an export of your session. The export file you create is a new
Microsoft Excel workbook that you can access outside of this system. Feel free to change formats,
create your own linked reports, etc. by utilizing this feature.
Exporting Your Session
Once you've completed your data input and reviewed the output, you can access the Export to Excel
dialog by clicking the Export to Excel toolbar icon.
Upon launching the dialog the Export What? section defaults to the Current Page. In this case, the
bottom-right section lists the name of the menu or submenu item currently in view.
To create a multi-page export, you can either select All Pages or Customize. As a result of selecting
All Pages, all active reports are listed in the below-right section in the order in which they appear in the
various reports menus.
Selecting Customize activates the Category drop-down list. All active reports are listed in the section
immediately below in the order in which they appear on screen. You can then build a customized export
by making your desired selections from the Category drop-down list. Clicking on the >> button moves
all items listed in the section under the drop-down menu to the Pages to Export section. Clicking on the
<< button moves the items back. You can also reorder the items listed by highlighting one item at a time
and clicking on the Up or Dn buttons until the item is placed where you want it.
NOTE: You can move individual items back and forth between sections by first highlighting the item and
then by clicking on the > and < buttons.
To create the Export Path where your export file will be created, click on the Browse button. This
brings up the Export window. Enter a file name in the File name section—the default name is <Planner
Name> Export.xlsx—and navigate to the desired destination for the export file. Click on Save to record
the Export Path and the export file name.
WARNING: The name of the export file cannot be the name of a WealthTec Suite planner. Violation of
this rule not only produces errors and causes a system crash, but the program replaces the planner with
the corrupted export file. This disaster can then be rectified only by reinstalling the program.
NOTE: If you've entered a default path for saving export files on the Settings/User Settings/General
tab, that path is recognized by the system. You'll notice that the system navigates to your default export
path when you select Export Path to open the Export window.
Once the bottom-right section of the Export to Excel dialog lists the desired output items in the
preferred order, click on the OK button. The program creates the export file from the items listed, in the
order in which they appear in this section.
Appending the Current Export to an Existing One
By default, each time you launch the Export to Excel dialog to build an Excel export, the program treats
the current export as a unique export file. If, after building the desired export, you click OK and have not
given the current export a unique name, the program prompts you to select one of two options:
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•

Overwrite the existing file that has the same name as the current export

•

Append the current export to the existing file so that nothing is overridden

The first alternative, overwriting the existing file, should be self-explanatory. The second option,
appending to an existing file, requires you to select the Append to Existing File option in the Export
What? section of the Export to Excel dialog. If this option is turned on, and the current export has the
same name as an existing export, the program inserts the current export at the end of the existing
export file. This enables you to create consolidated exports prior to printing or converting to a PDF file,
which may be desirable if you're producing reports from multiple planners and wish to make formatting
or other changes to a single export workbook globally.
NOTE: Unfortunately, an Excel file is limited to a single color scheme. Due to the variety of WealthTec
Suite reports, if you create a consolidated export that combines output from Pinnacle and/or DesignPro
with any other planner, you will have additional work to do. The color schemes in these planners are
different, so you will have to change the colors of some of the exported reports. On the other hand, so
long as you keep export files created from Pinnacle/DesignPro separate from export files created from
other planners, the appropriate color schemes will be exported as well.
Saving and Managing Custom Sets
You can establish exporting preferences in WealthTec Suite that are unique for each planner. Here's
how this feature works:
1.

Select Customize from the Export What? section.

2.

Create your custom report set by following the steps outlined in the Exporting Your Session
section above.

3.

Once the items listed in the below-right section meet your requirements, click Save in the Sets
section. This brings up the Save Set As dialog.

4.

Enter a name for the export set in the New Name block and click Save.

5.

Click New to build another custom set and repeat steps 1-4.

To rename a custom report set click the Rename button. This opens the Rename Set dialog. Enter a
new name in the New Name block, and select OK to record it.
To delete a custom report set click the Delete button. This opens the Delete Set? dialog where you'll be
prompted to confirm your desire to delete the selected custom report set. Select Yes to confirm or No to
cancel the delete command.
TIP: Reports are Case-sensitive, meaning that certain reports are activated or inactivated depending on
the Case data. Therefore, if you're using this feature, you should evaluate the merits of developing
alternative custom sets in a given planner.
NOTE TO MULTIUSER GROUPS: The custom report sets you develop for exporting and printing
purposes are stored in your user settings file (i.e., User.xls). You can develop various custom report
sets for the group as a whole, and distribute one User.xls file to the group. Click the Tools/User
Settings Folder to access the User.xls file. Copy the User.xls file that stores the group's custom report
sets, and paste it into the User Settings Folder for each user in the group. When prompted whether
you wish to overwrite the existing file select Copy and Replace in the Windows Copy File dialog.
Editing Flowchart Exports in Excel 2010/2013
Due to security concerns, Microsoft has essentially locked down the editing of flowchart object content.
Fortunately, WealthTec has uncovered an expedient workaround. To edit the content of an exported
flowchart object please follow these steps:
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1.

Enter the new content in a cell outside of the flowchart report print range.

2.

Select the object you wish to edit by left-clicking on it.

3.

In the Formula Bar type =<cell reference> and hit Enter.

NOTE: <cell reference> means that after typing the equal sign you navigate to and select the cell
containing your customized content.
Repeat steps 1-3 above for each object you wish to edit.

Printing
WealthTec Suite includes a custom report-building feature that offers you the freedom to do the
following in creating your deliverables:
•

Selectively include or exclude summaries, graphs, charts, schedules and cover pages in your
output

•

Reorder the report sheets at your discretion prior to printing

•

Print data input sheets for file documentation purposes

•

Save custom report sets and apply them across clients without having to rebuild your report
sets each time you launch the system, activate the printing function or change data files.

Printing Your Session
Once you've completed your data input and reviewed the output, you can access the Print dialog by
selecting Print Reports from the Print menu or by clicking the Print toolbar icon.
Upon launching the dialog the Print What? section defaults to the Current Page. In this case, the
bottom-right section lists the name of the menu or submenu item currently in view.
To create a multi-page report, you can either select All Pages or Customize. As a result of selecting All
Pages, all active reports are listed in the bottom-right section in the order in which they appear in the
various reports menus.
Selecting Customize activates the Category drop-down list and the section immediately below. You
can then build a customized report set by making your desired selections from the Category drop-down
list. Clicking on the >> button moves all items listed in the section under the drop-down menu to the
bottom-right section. Clicking on the << button moves the items back. You can reorder the items listed
by highlighting one item at a time and clicking on the Up or Dn buttons until the item is placed where
you want it.
NOTE: You can move individual items back and forth between sections by first highlighting the item and
then by clicking on the > and < buttons.
Once the bottom-right section lists the desired output items in the preferred order, click on the OK
button. This sends the sheets listed in bottom-right section to the printer you selected in the dialog
activated by clicking on Print/Printer Setup. Pages are printed out in the order in which they are listed.
NOTE: You can print out multiple copies by changing the value listed in the Number of Copies box,
either by using the spin control or by entering a number directly into the box. Checking the Collate box
ensures that multi-page reports are collated prior to printing.
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Pagination
If &P appears in any of the header/footer blocks on the Settings/User Settings/Header/Footer tab,
printed items are numbered consecutively on each individual printing session. Below are points worth
noting.
•

The page number that appears in the header or footer in a Print Preview session always
starts with "1," so do not be concerned.

•

If you print the reports by sections on an individual basis (e.g., Summaries, followed by
Charts, etc.), each section begins with page number "1." Thus, to create a single,
consecutively numbered analysis that includes all relevant reports, build the report set first in
its entirety before sending any output to the printer.

Saving and Managing Custom Sets
You can establish printing preferences in WealthTec Suite that are unique for each planner. Here's how
this feature works:
1.

Select Customize from the Print What? section.

2.

Create your custom report set by following the steps outlined in the Printing Your Session
section above.

3.

Once the items listed in the bottom-right section meet your requirements, click Save in the
Sets section. This brings up the Save Set As dialog.

4.

Enter a name for the print set in the New Name block and click Save.

5.

Click New to build another custom set and repeat steps 1-4.

To rename a custom report set click the Rename button. This opens the Rename Set dialog. Enter a
new name in the New Name block, and select OK to record it.
To delete a custom report set click the Delete button. This opens the Delete Set? dialog where you'll be
prompted to confirm your desire to delete the selected custom report set. Select Yes to confirm or No to
cancel the delete command.
TIP: Reports are Case-sensitive, meaning that certain reports are activated or inactivated depending on
the Case data. Therefore, if you're using this feature, you should evaluate the merits of developing
alternative custom sets in a given planner.
NOTE TO MULTIUSER GROUPS: The custom report sets you develop for exporting and printing
purposes are stored in your user settings file (i.e., User.xls). You can develop various custom report
sets for the group as a whole, and distribute one User.xls file to the group. Click the Tools/User
Settings Folder to access the User.xls file. Copy the User.xls file that stores the group's custom report
sets, and paste it into the User Settings Folder for each user in the group. When prompted whether
you wish to overwrite the existing file select Copy and Replace in the Windows Copy File dialog.
Printing a Presentation
The presentation printing feature offers you the freedom to do the following in creating your
deliverables:
•

Print slides or handouts

•

Print entire presentations or selected slides

•

Apply your custom settings to your deliverables
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•

If you're printing handouts, include multiple slides on a single handout page

NOTE: You can only print a linked presentation when working inside WealthTec Suite. Therefore, the
Print Presentation feature is active only when you're in a planner that has a presentation associated
with it. It is the linked presentation that you'll print when you launch the Print Presentation dialog.
TIP: All presentations can be opened outside of WealthTec Suite by opening them directly in a new
instance of PowerPoint. This enables you to edit and/or print any of WealthTec Suite's static
presentations.
The Presentation drop-down list box displays the name of the current planner. From the Print What?
drop-down list select either Slides or Handouts. If you select Handouts, move to the Handouts
section. There you can select the number of Slides per page (2, 3 or 6 is permissible). In addition, you
can orient the handouts in a Vertical or Horizontal layout by making the appropriate selection for
Handout order.
Next, select the desired format for your printouts in the Color/Grayscale section. While presentations
are generally designed to be shown in color, hard copies are often produced as Pure Black and White
or in shades of gray (i.e., Grayscale). Nevertheless, you can also print slides/handouts in Color if your
PowerPoint setup is connected to a color printer.
In the Print Range section, you can elect to include only a portion of a presentation in your print job. To
do so, select Slides and enter the first and last slide to include in the From and To blocks, respectively.
NOTE 1: Since the presentation you're setting up to print is not launched prior to printing, you'll have to
be familiar with the contents of the presentation beforehand if you intend to print selected ranges only.
Otherwise, you won't know which slides correspond to which slide numbers.
NOTE 2: The title slide is assigned the number 0; the content slides begin with 1.
Moving to the Copies section, you can print multiple copies by adjusting the Number of copies spinner
control. If you're printing multiple copies, the program collates the copies prior to printing if the Collate
box is checked.
Once your print settings are finalized, click OK to print.

Toolbar/Planners
Global
Click the Global toolbar icon to open Pinnacle, which is not only WealthTec Suite's global planner but
also its asset allocation planning tool.

Planners
Click the Planners toolbar icon to launch the WealthTec Suite Planners dialog. There you will find all
of the planners in this program. Highlighting a planner displays a brief description of its primary purpose
and functionality.
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Go To Last
Click the Go To Last toolbar icon to open the planner in which you were working just prior to opening
the current planner, if applicable.

Toolbar/Active Planner
Inputs
Listed under the Inputs menu are the data input screens for the active planner, all of which are
described in detail in the Data Input help section.

Reports
Some planners include a series of submenus (e.g., Summaries, Charts) listed under a single Reports
menu. These contain the various reports produced by WealthTec Suite.
NOTE 1: Due to their comprehensive and voluminous nature, Synergy, the Cash Flow & Estate Planner
and EstatePro substitute a series of report menus for the single Reports menu found in the remaining
planners.
NOTE 2: To fully understand the output of any WealthTec Suite planner you must not only review the
main summaries, graphs and flowcharts but also the detailed supporting schedules.

Navigation
Home
Click the Home toolbar icon to move to the first input screen in the current planner.
Back
Click the Back toolbar icon to navigate to the immediately preceding active screen.
Forward
Click the Forward toolbar icon to navigate to the immediately succeeding active screen.
NOTE: Moving from the data input area to the Reports area causes the program to calculate the results
and build the reports if the program detects that a change has been made on the input screens.

Toolbar/Presentations
Static
WealthTec Suite includes of a series of PowerPoint presentations covering a variety of wealth planning
topics. Clicking on the Static toolbar icon launches the WealthTec Suite Presentations dialog, which
lists all available PowerPoint presentations in alphabetical order. Selecting a presentation by single-
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clicking on its name causes the program to display a brief description for that presentation. Open a
presentation by clicking the Open button or click Cancel to return to the current screen.
NOTE: By launching a presentation WealthTec Suite automatically opens PowerPoint in slide show
mode. You can work through the presentation by hitting the Page Down key on your keyboard or by
clicking directly on each slide. To exit a presentation hit your Escape key.

Linked
Several WealthTec Suite presentations are closely associated with particular planners. You can launch
these presentations in a context-sensitive manner by clicking on the Linked toolbar icon when the
corresponding planner is the active planner. For instance, when the GRAT Planner is the active planner
clicking on the Linked icon launches the Grantor Retained Annuity Trust presentation.
In some instances, the active planner uploads the current Case data into the linked presentation, and
replaces the slides that display graphical examples with slides containing live data.
NOTE: Selecting Print/Print Presentation when the active planner is capable of uploading current
Case data creates a printout of the linked presentation. This is a nifty way of creating PowerPoint
deliverables that reflect real world client planning situations.
Following is a list of planners that upload current Case data into the corresponding linked presentation:
•

CLAT Planner

•

CLUT Planner

•

CRAT Planner

•

CRUT Planner

•

FlipCRUT Planner

•

GRAT Planner

•

IDGT Planner

•

NIMCRUT Planner

•

QPRT Planner

Toolbar/Help
Quick Start Guide
The WealthTec Suite Quick Start Guide provides initial guidance in several key areas of the program.
You can access it by clicking the Quick Start toolbar button. This document does not provide
comprehensive or detailed guidance regarding the suite, but covers the software's essential features
(e.g., managing case data, exporting, and printing). You may want to review the Quick Start Guide as a
preliminary introduction to WealthTec Suite before delving more deeply into the help system or the
comprehensive user manual.

Context-Sensitive Help
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In addition to the comprehensive online help you can activate WealthTec Suite's context-sensitive help
whenever you're working in a planner's data input area by clicking the Help toolbar button. The data
input guidance included in the help system is extensive. It not only provides instructions for entering
data, but also includes examples, tips and caveats. Moreover, familiarity with the content of the data
input help (and system conventions) can assist you in interpreting WealthTec Suite's reports.
NOTE: In addition to context-sensitive data input help, you can also access guidance covering the main
annual summaries in the strategic planning tools by clicking the Help toolbar button when you're
reviewing one of those report screens (e.g., the Annual Cash Flows & Projected Net Worth Summary
report in EstatePro).

Comprehensive Online Help
WealthTec Suite includes a comprehensive online help system that is integrated with the program. The
help system has been organized into sections covering everything from the effective use of the system
through system conventions to detailed data input help. WealthTec highly recommends that you rely on
this help system as much as possible for general and specific guidance regarding use of the software.
Considerable thought and energy has been invested in the development of the online help, which was
written exclusively by WealthTec Suite's author and developer, Howard L. Eisenberg.
NOTE: To access the online help anytime click the Help toolbar button or select Help from the Help
menu.

User Manual
To supplement the integrated online help system, WealthTec converted its content into a
comprehensive user manual with a PDF format. The user manual is readable by the Adobe Acrobat
Reader® software, which you can download at no charge from www.adobe.com.
You can access the user manual during a WealthTec Suite session by selecting User Manual from the
Help menu. You can also access the manual anytime by selecting Start/WealthTec/WealthTec Suite
User Manual.
NOTE: The user manual is quite voluminous. Therefore, WealthTec does not recommend that you print
it out in its entirety. Keep in mind that when the software is updated so are the relevant sections in the
online help and user manual. Therefore, if you print the manual at any time, just keep in mind that parts
of it will be rendered obsolete with subsequent updates.

Email Support
When you need specific guidance relating to a Case during a WealthTec Suite session please select
Email Support from the Help menu. This launches your computer's native email program (e.g.,
Microsoft Outlook®) and inserts howard@wealthtec.com in the To or Mail to block.
NOTE: Your email will be directed to Howard L. Eisenberg, WealthTec's president and
author/developer of WealthTec Suite.
Please make sure to include your Client data file in your correspondence. That way WealthTec can
load your data into its own WealthTec Suite setup and build the reports. Submitting your Client data
file helps WealthTec provide the highest quality customer support.
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There are two ways of transmitting your Client data file:
Using Your Email Client
1.

After selecting Email Support from the Help menu, and inserting your email address in the
From block, navigate to the location of your Client data files, and select the active data file as
a standard email attachment.

2.

Add your comments and/or questions in the body of the message and submit the message to
WealthTec.

NOTE: Select User Settings Folder from the Tools menu to navigate to WealthTec Suite's default
Data folder if your Client data files are maintained in the default location.
Alternative for Special Situations
In limited situations, WealthTec may instruct you to follow the method outlined below in lieu of the
method described above.
1.

Create a copy of the Client data file.

2.

Right-click the .dat file and select Rename.

3.

Replace the .dat extension with .xlsx.

4.

Follow the steps immediately above under Using Your Email Client to submit the .xlsx file.

NOTE 1: While there is no need to submit a copy of your Excel export with your Client data file
routinely, in some situations it can be helpful. For instance, if you've added some calculations of your
own that show a different result than what the WealthTec Suite planner has produced, supplying
WealthTec with your export file can help resolve those differences more quickly.
NOTE 2: Rest assured that WealthTec maintains strict client confidentiality at all times, including Client
data files in its possession. Furthermore, once the issues relating to your Case have been resolved,
WealthTec deletes the Client data file you submitted from its computers.

Software Updates
Selecting Software Updates from the Help menu launches your Web browser, and takes you to the
wealthtec.com/downloads/ page. This is the location on WealthTec's site where the most current
WealthTec Suite setup file can be accessed and downloaded. There you will also find a link to the
Release Notes document, which highlights current-year WealthTec Suite developments.

About the Software
Selecting About from the Help menu opens the About WealthTec Suite dialog, which displays the
Version of the software installed on your system, along with the Product Key that was entered during
the setup routine. You will also see the date when the program was Installed and the date it Expires.
Comparing the version number displayed in this dialog with the version number posted on the
wealthtec.com/downloads/ page lets you determine how up to date your WealthTec Suite setup is.
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NOTE: If you originally used the demo version of the program, and have purchased a license to the
standard edition, you can enter the new Product Key supplied by WealthTec by clicking the Edit Key
button and entering the new key.
Select OK to record the new Product Key and/or to close the About WealthTec Suite dialog.
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Support/General
Support Overview
WealthTec considers customer and product support to be an integral part of your WealthTec Suite
experience. We expend considerable effort in ensuring that your questions are answered and problems
resolved in a timely manner. As a former financial and estate planning practitioner, Howard L. Eisenberg
is able to offer a unique level of personalized support. He can not only answer questions relating to the
software but, where appropriate, also add his professional insights regarding the planning challenge at
hand. Over the years, many satisfied WealthTec Suite users have commented on the value of his
software-related and planning-related expertise.
The following important topics relate to customer and product support:
•

Integrated WealthTec Suite Guidance

•

WealthTec-Excel Integration

•

WealthTec Suite Errors

•

#VALUE! & #NAME? Errors

•

Diagnosing Input Errors

•

Reports Not Properly Updated

•

Contact Information

•

Emailing Data Files to WealthTec

•

Web-Based Training

The help sections that follow provide additional commentary.

Support/Integrated with Software
Integrated WealthTec Suite Guidance
Extensive guidance is integrated with the installed WealthTec Suite program. This includes a Quick
Start Guide, comprehensive user manual and integrated online help (including context-sensitive help).
Please refer to the Technical Architecture & Functionality/Help section for details.

Support/Troubleshooting
WealthTec-Excel Integration
WealthTec Suite includes Excel-based and PowerPoint-based planning tools and presentations, along
with certain technical components that are integrated with Microsoft Office as Excel add-ins. Any
disruption of the WealthTec-Excel integration will disrupt the operation of WealthTec Suite. The
WealthTec Suite setup file installs all of the required components.
After installing WealthTec Suite the WealthTecApp.dll/WealthTecApp64.dll,
WealthTecLib.dll/WealthTecLib64.dll and WealthTec.xll/WealthTec64.xll files will be located in the
C:\Program Files (x86)\WealthTec\WealthTec Suite (32-bit version) or C:\Program
Files\WealthTec\WealthTec Suite (64-bit version) folder. These files are responsible for the proper
launching and operation of WealthTec Suite.
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When the WealthTec Function Library is not integrated properly you will see errors on the input and
output screens. This is usually corrected by following the steps outlined in the Support/Troubleshooting:
#VALUE! & #NAME? Errors help section. If this does not correct the errors—or you see 0.0 in the Age
and Calculated life expectancy fields on the first input screen in a planner— it's likely that the
WealthTec.xll/WealthTec64.xll file is not installed correctly.
Please contact WealthTec for assistance if you've already followed the guidance outlined in the
Support/Troubleshooting: #VALUE! & #NAME? Errors help section but are still having problems.

Excel Security Settings
WealthTec Suite includes a limited number of Excel® macros, which are strings of commands that
control certain functions within the system. These macros are essential to the proper functioning of the
program and inactivating them—whether intentionally or not—prevents the program from performing
certain tasks as designed.
NOTE: The VBA.xls file contains a module that stores the macros' visual basic source code. This
module bears the WealthTec LLC digital signature obtained from Thawte, a global third-party digital
security firm owned by Symantec, maker of the Norton® family of digital security applications.
Currently, the most important WealthTec Suite feature controlled by VBA macros is the TabOrder
procedure, which is responsible for input screen navigation. If you're experiencing problems with input
screen navigation it is likely because your Excel security settings are preventing the macros within the
VBA.xls file from being activated. If so, please follow the steps below.
1.

Close WealthTec Suite.

2.

Open Excel.

3.

Select File/Options.

4.

Select Trust Center/Trust Center Settings/Trusted Locations/Add New Location.

5.

Click the Browse button and navigate to C:\Program Files (x86)\WealthTec or C:\Program
Files\WealthTec and click OK.

6.

Click the box Subfolders of this location are also trusted box and click OK.

7.

Select Macro Settings/Disable all macros except digitally signed macros.

8.

Click OK (as many times as is necessary to get out of the Trust Center).

9.

Close Excel and launch WealthTec Suite.

IMPORTANT: If upon launching WealthTec Suite you do not see the WealthTec Toolbar (i.e., only the
WealthTec Suite splash screen is visible) the most likely culprit is an Excel security setting. Please
follow the steps below to enable the program to properly load the WealthTec Toolbar.
1. Close WealthTec Suite.
2. Open Excel.
3. Select File/Options.
4. Select Trust Center/Trust Center Settings/Add-ins.
5. Uncheck Require Application Add-ins to be signed by Trusted Publisher.
6. Uncheck Disable all Application Add-ins (may impair functionality).
7. Click OK (as many times as is necessary to get out of the Trust Center).
8. Close Excel and launch WealthTec Suite.
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Excel AutoRecover Settings
Excel has an AutoRecover feature that runs in the background when Excel is open, meaning that it’s
active and processing during your WealthTec Suite sessions. You can find the settings by opening
Excel on its own, selecting File/Options/Save. The settings are near the top of that page.
If you work in Excel frequently, and are used to relying on this feature, then keep it as is when you’re
just working in Excel. However, the problem with AutoRecover as it relates to WealthTec Suite is that
Excel is actually trying to save a copy of the open Excel files (not the Client data file, ironically) during
your sessions. This could cause problems if your WealthTec Suite sessions are time-consuming,
especially if you're working in the Cash Flow & Estate Planner or EstatePro—these are large Excel
spreadsheets. You may notice that the Excel hourglass pops up periodically, which forces you to stop
your work temporarily—inconvenient at best but problematic at worst. This is Excel saving the planner in
which you're working, along with other open WealthTec Suite files.
WealthTec disables its AutoRecover settings, because we a) save our work frequently; b) prefer not to
rely on Excel to recover anything (file versions can get confusing); and c) find that the feature is
generally too disruptive to leave it in activated state.
WealthTec recommends that you dismantle AutoRecover while working in WealthTec Suite.
Alternatively, if you choose to keep the settings active at all times, perhaps you can increase the time
interval defined by the Save AutoRecover information every <> minutes setting. Over the years,
disabling AutoRecover has been a successful troubleshooting measure when mysterious performance
issues have arisen in WealthTec Suite.

WealthTec Suite Errors
You may encounter error messages that have the label WealthTec Suite in the pop-up window's title
bar during a WealthTec Suite session. Some of these errors are directly related to the disruption of the
WealthTec-Excel integration; these are typically suggested by the presence of #VALUE! and/or
#NAME? errors on the first input screen in a planner. Other errors may relate to faulty data input.
NOTE: Most WealthTec Suite run-time errors will trigger an error message that includes the word
Render as in Error in RenderHideRows.
Assuming that you do not see #VALUE! or #NAME? in the Age and Calculated life expectancy fields on
the planner's first input screen, you have not run afoul of the "no blanks" data input rule (please refer to
the Support/Troubleshooting: Diagnosing Input Errors help section for details), and you see Render in
the error message, you should submit the active Client data file to WealthTec for a diagnosis and
proposed cure.
NOTE: Please refer to the Technical Architecture/Help: Email Support help section for details
concerning the submission of Client data files.
In still other situations, you may not be able to save data, navigate around the suite, etc., all the while
triggering additional error messages (e.g., Error in SetEntry). Here, some component of the current
WealthTec Suite installation has probably been temporarily disrupted. Simply reinstalling the program
typically clears up the problem.

#VALUE! & #NAME? Errors
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Most WealthTec Suite run-time errors are caused by a disrupted integration between Excel and the
WealthTec Function Library and/or the WealthTec Excel Addin. A majority of the others are caused
by one or more data input errors. Each of these types of problems is resolved quite easily, but the
manner in which they're corrected differs.
When the WealthTec Function Library-Excel integration is disrupted—this may occur after installing a
WealthTec Suite update, but can occur at other times—you will see #VALUE! or #NAME? errors on the
first input screen in a planner in the Age and Calculated life expectancy fields. The planner will not be
able to calculate these and other results, so when you try to build reports you will likely trigger error
messages that start with Error in RenderHideRows or Error in RenderHideColumns. Other messages
with WealthTec Suite in the title bar of the error message pop-up window may also be seen. #VALUE!
and/or #NAME? errors may also appear in the reports.
When this occurs please do not panic. Just close WealthTec Suite, and take a deep breath. You have
two alternatives for reestablishing the connection between the WealthTec Function Library and Excel:
1.

The one-step method;

2.

The multistep method.

Under most circumstances, following the simple one-step method will be effective. If it is not, however,
you can achieve your objective by following the multistep method. Each of these alternatives is
explained below.
One-Step Method
The following steps are intended to reregister the WealthTec Function Library (i.e., the
WealthTecLib.dll/WealthTecLib64.dll file) with Excel, so that you can effectively operate WealthTec
Suite.
1.

Select Start/WealthTec/Reset Function Library to launch and execute the procedure.

2.

Click OK to close the message window.

Multistep Method
1.

Open Excel.

2.

Select File/Options in the top-left corner.

3.

Select Add-Ins in the left pane.

4.

Select WealthTec Function Library from the Add-ins list.

5.

Select Excel Add-ins from the Manage drop-down list and click Go.

6.

Click the WealthTec Function Library box in the Add-Ins dialog, and then click OK.

That's it. The next time you launch WealthTec Suite you should no longer see #VALUE! or #NAME?
errors, and the program will be able to perform its functions normally.
TIP: Do not attempt to print or export reports before reviewing them on screen. If you cannot build the
reports on screen without triggering error messages you will not be able to print or export them either.

Diagnosing Input Errors
In many cases WealthTec Suite can detect a data input error up front, in which case an error message
pops up, instructing you which data are acceptable. Unfortunately, the program cannot detect certain
types of data input problems. The most important of these relates to blank input fields.

 Copyright 1999-2019 WealthTec LLC. All Rights Reserved.

29

WealthTec® Suite Technical Guide: 2019 Edition

IMPORTANT: A blank input field is acceptable only for manually-entered text items (e.g., an asset
description). A blank input field is not acceptable anywhere else, and the system is unforgiving in this
regard. Thus, for example, if a Growth Rate field is blank you will see a series of error messages when
you attempt to build the reports. The reports, in turn, will be canvassed with errors (e.g., #NUM!,
#VALUE!) and will be useless.
If you wish to eliminate, say, income and/or growth relating to a particular asset enter 0% for the
income/growth rate. Do not, under any circumstances, hit your Delete key to eliminate the
income/growth rate.
TIP: Let the program's default assumptions guide you with respect to what's acceptable and what is not
(i.e., in terms of whether it's acceptable to have a blank input field or not).

Reports Not Properly Updated
Under normal circumstances, WealthTec Suite's reports reflect current inputs. However, heavy use of
the program during a single session may cause inputs and outputs to become temporarily disconnected
(e.g., an input screen update may not be reflected in the reports). Unfortunately, this is not something
WealthTec Suite can control, because the program merely sends instructions to Excel for the latter to
perform. In this situation, the temporary solution is to save the active Case, and exit the program. You
can then relaunch the program, reload the Client data file and the desired Case, and rebuild the
reports.
A more permanent solution to this problem is to invest in a hardware upgrade—specifically more
computer memory. While the minimum memory requirement for a proper functioning WealthTec Suite
setup is 4GB (12GB for the Cash Flow & Estate Planner and EstatePro), you may need to double your
PC's memory to see improved performance. This is especially true if you rely heavily on the export (or
other memory-intensive) functions.

Returning Excel to Its Native State
If upon launching Microsoft Excel to work on an Excel spreadsheet you see the custom WealthTec
Toolbar in lieu of the native Excel ribbon, you need a reliable method for disconnecting the WealthTec
Excel Addin from Excel. This section outlines that approach.
In order to return Excel to its native state follow these steps:
1.

Close Excel.

2.

Select Start/WealthTec/Reset Excel to launch and execute the procedure.

NOTE: This disconnects the WealthTec Excel Addin (i.e., the WealthTecApp.dll/WealthTecApp64.dll
file) from Excel. Click OK to close the message window. You should now be able to launch and work in
Excel successfully.

WealthTec Suite Crashes
Microsoft Excel is one of the most robust programs ever developed, and we are all indebted to Microsoft
for blessing us in the wealth advisory field with such a powerful tool. That said, we all encounter Excelrelated headaches from time to time—it can be as finicky as an old cat.
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Since WealthTec Suite relies on a seamless integration with Excel (and PowerPoint), any hiccups in
the operation of WealthTec Suite or its de facto host can cause a crash of either. In those situations,
we need a reliable approach to getting both programs back online in a timely manner. This section
outlines that approach.
Disconnecting, Unregistering and Removing the WealthTec Excel Addin from Excel
The first step to getting these programs back in working order is to disconnect, unregister and
completely remove the WealthTec Excel Addin from Excel. To do so, follow these steps:
1.

Close WealthTec Suite and Excel.

2.

Select Start/WealthTec/Unregister Excel Addin to launch and execute the procedure.

NOTE: This returns Excel to its native state by completely removing the WealthTec Excel Addin (i.e.,
the WealthTecApp.dll/WealthTecApp64.dll file) from Excel. Click OK to close the message window.
Reconnecting the WealthTec Excel Addin
The following steps are intended to reregister the WealthTec Excel Addin (i.e., the
WealthTecApp.dll/WealthTecApp64.dll file) with Excel, so that you can effectively launch and operate
WealthTec Suite.
1.

Select Start/WealthTec/Register Excel Addin shortcut to launch and execute the procedure.

2.

Click OK to close the message window.

NOTE: If after following the above steps you cannot effectively launch WealthTec Suite you can
reinstall the program and/or follow the steps below to manually reregister the WealthTec Excel Addin.
1.

Select File/Options in the top-left corner.

2.

Select Add-Ins in the left pane.

3.

Select WealthTec Excel Addin from the Inactive Application Add-ins list (see NOTE below).

4.

Select COM Add-ins from the Manage drop-down list and click Go.

5.

Check the WealthTec Excel Addin box, and then click OK to close.

NOTE: If the WealthTec Excel Addin appears under Disabled Application Add-ins instead of
Inactive Application Add-ins please follow the steps below.
1.

Select Disabled from the Manage drop-down list.

2.

Select WealthTec Excel Addin from the list and click Go.

3.

Check the WealthTec Excel Addin box, and then click Enable followed by OK to activate the
add-in and close the dialog.

4.

Exit Excel.

The next time you launch WealthTec Suite the WealthTec Toolbar should be present.
NOTE: If you've followed the steps above and still have trouble reestablishing the integration between
the WealthTec Excel Addin and Excel (i.e., the WealthTec Toolbar does not properly load upon
launching WealthTec Suite), it's possible that Excel is set to run as administrator on your computer. If
that is the case, changing your Excel settings so that it runs without administrative privileges may fix the
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WealthTec-Excel integration. To ensure that Excel does not run as administrator, please follow the
steps below.
1.

Navigate to the EXCEL.EXE (or excel.exe) executable file. The 32-bit version is located at
C:\Program Files (x86)\Microsoft Office\Office<version>\EXCEL.EXE (or excel.exe). The 64-bit
version is located at C:\Program Files\Microsoft
Office<version>\root\office<version>\EXCEL.EXE (or excel.exe).

2.

Right-click the Excel executable and select Properties/Compatibility.

3.

Under Privilege Level uncheck the Run this program as an administrator box.

4.

Click Apply and then OK.

The next time you launch WealthTec Suite the WealthTec Toolbar should be present. However, if
you're still experiencing problems after following the above guidance please contact WealthTec.

Support/Contacting WealthTec
Contact Information
You can visit WealthTec at its home: wealthtec.com. There you'll find a wealth of information
concerning WealthTec Suite, including current developments, pricing, etc. That's also where you'll find
the latest version of the software. Please direct your questions or comments to the individual below.
Howard L. Eisenberg, CPA/PFS, CFP®, CIMA®, CPWA®, CTFA®, CLU®, ChFC®, CASL®
President
Tel: (301) 725-1437
Fax: (301) 725-1593
Mobile: (240) 463-2030
Email: howard@wealthtec.com
WealthTec LLC
11446 Iager Blvd
Fulton, MD 20759

Emailing Data Files to WealthTec
When you need specific guidance relating to a Case (e.g., you don't understand a calculated result),
please contact WealthTec via email at howard@wealthtec.com. Please make sure to include your
Client data file in your correspondence. That way WealthTec can load your data into its own
WealthTec Suite setup and build the reports. Submitting your Client data file helps WealthTec provide
the highest quality customer support.
Please refer to the Technical Architecture & Functionality/Help: Email Support help section for guidance
relating to contacting WealthTec for support.

Support/Formal Training
Web-Based Training
In addition to the online help, user manual, and WealthTec's live support via email and phone, formal
WealthTec Suite training is also available.
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The formal training is conducted online through a series of Web-based sessions. These training
sessions are performed by an independent, third party software consultant who is a highly experienced
WealthTec Suite user and a well-respected financial and estate planning practitioner.
Fees for the training sessions are negotiated directly with the trainer and depend on the scope of the
sessions, which is a function of your specific needs. If you'd like to take advantage of the formal training
opportunity please contact WealthTec, which will provide you with the relevant contact information.
WealthTec has heard from many satisfied clients who have been able to use WealthTec Suite more
effectively as a result of the training.
DISCLAIMER: WealthTec has no financial interest in the trainer's firm or in the training sessions, either
directly or indirectly.
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